Cardsetup Software

Version 1.0

for

DP4100 Digital Player

Installation and Operation Manual

Issue03 April 2016

DV 62500.05 Article-Number 0544.736-071

Becker Avionics GmbH • Baden-Airpark B108 • 77836 Rheinmünster • Germany
+49 (0) 7229 / 305-0 • Fax +49 (0) 7229 / 305-217
http://www.becker-avionics.com • E-mail: info@becker-avionics.com

23-30-06
FIRST ISSUE AND CHANGES

Issue01 February 2001
Issue02 November 2002
Issue03 April 2016

LIST OF EFFECTIVE PAGES

<table>
<thead>
<tr>
<th>SUBJECT</th>
<th>PAGE NO.</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Page</td>
<td>1</td>
<td>04/2016</td>
</tr>
<tr>
<td>List of Effective Pages</td>
<td>2</td>
<td>04/2016</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>3 to 4</td>
<td>04/2016</td>
</tr>
<tr>
<td>Section 1</td>
<td>5 to 6</td>
<td>04/2016</td>
</tr>
<tr>
<td>Section 2</td>
<td>7</td>
<td>04/2016</td>
</tr>
<tr>
<td>Section 3</td>
<td>8</td>
<td>04/2016</td>
</tr>
<tr>
<td>Section 4</td>
<td>9</td>
<td>04/2016</td>
</tr>
<tr>
<td>Section 5</td>
<td>10 to 12</td>
<td>11/2002</td>
</tr>
<tr>
<td>Section 6</td>
<td>13</td>
<td>11/2002</td>
</tr>
<tr>
<td>Section 7</td>
<td>14 to 15</td>
<td>11/2002</td>
</tr>
<tr>
<td>Section 8</td>
<td>16 to 25</td>
<td>11/2002</td>
</tr>
<tr>
<td>Section 9</td>
<td>26 to 31</td>
<td>11/2002</td>
</tr>
</tbody>
</table>

DV 62500.05 / Article-No. 0544.736-071
Table of Contents

1. Scope ...........................................................................................................................................5
   1.1. Scope of delivery ..........................................................................................................................5
   1.2. Accessories ....................................................................................................................................5
2. Requirements .....................................................................................................................................7
   2.1. System ...........................................................................................................................................7
   2.2. Data Format ...................................................................................................................................7
   2.3. Flash Card ....................................................................................................................................7
   2.4. Compact Flash Card (CF) .............................................................................................................7
       2.4.1. CF + PCMCIA adapter .........................................................................................................7
3. Implementation Notes .........................................................................................................................8
4. How To ...............................................................................................................................................9
   4.1. How to copy/clone the existing card .............................................................................................9
   4.2. How to reduce card capacity down to 2 GB .................................................................................9
5. Installation ........................................................................................................................................10
   5.1. Starting Installation ....................................................................................................................10
   5.2. Destination Folder .....................................................................................................................10
   5.3. Program Folder ...........................................................................................................................11
   5.4. Copying Files ..............................................................................................................................12
   5.5. Setup Complete ..........................................................................................................................12
6. Starting Software ..............................................................................................................................13
   6.1. Main Screen ................................................................................................................................13
   6.2. MENU Bar ....................................................................................................................................13
   6.3. TOOLBOX Bar .............................................................................................................................13
   6.4. CARD TREE Window ................................................................................................................13
   6.5. BROWSER Window ...................................................................................................................13
   6.6. MESSAGE Window ....................................................................................................................13
7. Menus & Submenus ..........................................................................................................................14
   7.1. File Menu ....................................................................................................................................14
       7.1.1. Start a new Project ................................................................................................................14
       7.1.2. Open an existing Project .......................................................................................................14
       7.1.3. Save the current Project ..........................................................................................................14
       7.1.4. Save the current Project as new Project ..............................................................................14
   7.2. Option Menu ................................................................................................................................14
       7.2.1. Change the settings for the current Project .........................................................................14
       7.2.2. Create the final player card ................................................................................................14
   7.3. Navigator Toolbox .....................................................................................................................15
       7.3.1. Project Management ..........................................................................................................15
       7.3.2. Integrated MP3 Player .........................................................................................................15
8. Creating an Announcement Card ......................................................................................................16
   8.1. Introduction ................................................................................................................................16
   8.2. Setting up the Project ................................................................................................................17
   8.3. Definition of Mission Languages ..............................................................................................18
   8.4. Defining an Announcement within a Mission ............................................................................19
   8.5. Assigning an Announcement ......................................................................................................20
   8.6. More Missions and Announcements .........................................................................................20
   8.7. Removing Missions and Announcements ..................................................................................20
   8.8. Overwriting Links ......................................................................................................................20
   8.9. Application Settings ..................................................................................................................21
       8.9.1. Language Mangement ........................................................................................................21
       8.9.2. Defining a new Language ....................................................................................................22
Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Destination Folder Setup</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Program Folder Setup</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>Start Copying Files</td>
<td>12</td>
</tr>
<tr>
<td>4</td>
<td>Setup Complete</td>
<td>12</td>
</tr>
<tr>
<td>5</td>
<td>Main Window</td>
<td>13</td>
</tr>
<tr>
<td>6</td>
<td>File Menu</td>
<td>14</td>
</tr>
<tr>
<td>7</td>
<td>Options Settings</td>
<td>14</td>
</tr>
<tr>
<td>8</td>
<td>Option Create Card</td>
<td>15</td>
</tr>
<tr>
<td>9</td>
<td>Navigator Toolbox</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>Context Menu for Announcement Cards</td>
<td>16</td>
</tr>
<tr>
<td>11</td>
<td>New Mission</td>
<td>17</td>
</tr>
<tr>
<td>12</td>
<td>Mission Options</td>
<td>18</td>
</tr>
<tr>
<td>13</td>
<td>Announcement Languages</td>
<td>19</td>
</tr>
<tr>
<td>14</td>
<td>Announcement File</td>
<td>20</td>
</tr>
<tr>
<td>15</td>
<td>Existing Link Warning</td>
<td>20</td>
</tr>
<tr>
<td>16</td>
<td>Application Settings</td>
<td>21</td>
</tr>
<tr>
<td>17</td>
<td>Define new Language</td>
<td>22</td>
</tr>
<tr>
<td>18</td>
<td>Saving the Project</td>
<td>23</td>
</tr>
<tr>
<td>19</td>
<td>Link Error</td>
<td>24</td>
</tr>
<tr>
<td>20</td>
<td>Announcement File Information</td>
<td>24</td>
</tr>
<tr>
<td>21</td>
<td>Create Announcement Card</td>
<td>25</td>
</tr>
<tr>
<td>22</td>
<td>Context Menu Audio</td>
<td>26</td>
</tr>
<tr>
<td>23</td>
<td>Music Card Structure</td>
<td>26</td>
</tr>
<tr>
<td>24</td>
<td>Track File Window</td>
<td>27</td>
</tr>
<tr>
<td>25</td>
<td>Cardsetup</td>
<td>28</td>
</tr>
<tr>
<td>26</td>
<td>Settings</td>
<td>28</td>
</tr>
<tr>
<td>27</td>
<td>Save Audio Project</td>
<td>30</td>
</tr>
<tr>
<td>28</td>
<td>Create Card</td>
<td>31</td>
</tr>
</tbody>
</table>
1. **Scope**

This document is an introduction and explanation of the DP4100 Cardsetup Software. With the assistance of this document the user will be able to generate Flash Cards Announcement and / or Music play back together with the Becker Avionics DP4100 Digital Player.

For a description of the DP4100 Digital Player refer to the following DP4100 manuals:

- DV 62500.03 "Aircraft Maintenance Manual" Article-No. 0530.700-071
- DV 62500.04 "Component Maintenance Manual" Article-No. 0530.719-071

1.1. **Scope of delivery**

The following articles are contained in the scope of delivery:

<table>
<thead>
<tr>
<th>Name of the item</th>
<th>Article-No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP4100 Cardsetup Software (CD-ROM incl. manuals in PDF format)</td>
<td>0546.763-909</td>
</tr>
<tr>
<td>Cardsetup Software for DP4100 Installation and Operation Manual</td>
<td>0544.736-071</td>
</tr>
</tbody>
</table>

1.2. **Accessories**

<table>
<thead>
<tr>
<th>Name of the item</th>
<th>Article-No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo Flashcard</td>
<td>0546.658-909</td>
</tr>
<tr>
<td>Compact Flashcard 2 GB with ATA-Adapter</td>
<td>0648.744-956</td>
</tr>
</tbody>
</table>

Note: The Compact Flashcard 2 GB with ATA-Adapter can replace the ATA-Flashcards.

Note: The free memory space of used cards depends on the preinstalled data files.

The contents of this document is property of

Becker Avionics GmbH • Baden Airpark
D-77836 Rheinmünster • Germany

and may not be copied or duplicated or published without written consent.

©2016 by Becker Avionics GmbH, all rights are reserved.
2. Requirements

2.1. System

The minimum installation for proper operation should be:

- PC or Laptop with Windows 95/98 (NT)
- CD-ROM drive
- Soundcard and Soundsystem
- PCMCIA connector

The PCMCIA connector may be included (Notebooks ...) or connected via special hardware or local printer port. The drive must be accessible via a drive letter. In general standard hardware will work fine.

2.2. Data Format

The program works like a post-processor and expects all sound files, speech and music, in mp3 file format. All files must have the extension mp3.

2.3. Flash Card

For operation with the DP4100 only Flash Cards of type 1 or type 2 with ATA file system must be used. Linear Flash cards will not work. Type 3 flash cards will not fit into the DP4100 player.

We recommend to use Flash Cards from SanDisk Inc. they have been 100% tested and are available from company Becker Avionics. There is no guaranty of proper operation if other Flash Cards than those from SanDisk are used.

All available memory sizes from SunDisk Flash Cards can be used.

2.4. Compact Flash Card (CF)

Today the media type (PCMCIA) Flashdisk is not longer available on the market. The PCMCIA interface is in fact a superset of 40-pin AT Attachment (ATA) interface and 50-pin Compact Flash (CF) interface. So makes it possible to connect the named interfaces with a special pin-to-pin adapter, containing no electronic components.

The card should be preliminary inserted into a PCMCIA adapter and then they can be used as a Flashdisk replacement.

2.4.1. CF + PCMCIA adapter

The following combinations were tested:

- **Adapters**: Epson, NoName, Pretec, Targa Visionary.
- **Cards**: SanDisk CF 512 MB, SanDisk Ultra II 4 GB, SanDisk Ultra II 8 GB.

All of named combinations were working without any problem.
3. **Implementation Notes**

Following restrictions should be taken into account:

- The DP4100 digital player can play .mp3 records with the max constant bitrate 160 kB/s.
- The DP4100 digital player can play .mp3 records with the max variable bitrate 180 kB/s.
- The DP4100 digital player can accept cards with the max size 2 GB.
- The DP4100 digital player can accept cards FAT formatted only.

The described operations were tested for Window XP, Windows 7/8, Windows 10 operational systems (OS).
4. **How To**

The following steps describe main operations with cards and adapters and are independent of card and/or adapter type. **PCMCIA, CF** or the USB card adapters/readers can be used. Physical capacity is a maximum volume of information that could be placed on the card. Card size is the maximum volume of information that could be placed on the partitioned and formatted card part.

4.1. **How to copy/clone the existing card**

The operation can be used to replace the existing Flashdisk media.

- Download the executable copy/clone tool:  
  http://hddguru.com/software/HDD-Raw-Copy-Tool/HDDRawCopy1.10Setup.exe
- Insert the source card into adapter/reader and start the copy/clone tool.
- Create and save the source card image, then close the tool.
- Insert the target card into adapter/reader and start the copy/clone tool. The physical capacity of target card should not be less than source card size.
- Create and save the target card using source card image, then close the tool.

The target card is now the exact byte-by-byte copy/clone of the source card.

4.2. **How to reduce card capacity down to 2 GB**

If the physical card capacity exceeds 2 GB the card size should be reduced.

- Insert the card into adapter/reader and ensure the card is visible for OS. Use e.g. Windows Explorer for this.
- Open the OS command prompt typing in series “WinKey + R”, “cmd”, Enter.
- In the command prompt type “diskpart”. You should see “DISKPART>” prompt now.
- In the command prompt type “list disk”. Find the corresponding card and its number in the occurring media table.
- In the command prompt type “select disk N”, where N is the card number in the disk list.
- In the command prompt type “list disk” again. Ensure the needed card media is marked with “*”.
- In the command prompt type “clean”. Card partition and card format will be deleted.
- In the command prompt type “create partition primary size=2047”. The card partition with the size 2 GB will be created now.
- In the command prompt type “format fs=fat quick”. The card will be now formatted.
- In the command prompt type “exit”. The command prompt will be now closed.

The card is now prepared to be used as a DP4100 media and the data system can be created using card setup software.
5. **Installation**

5.1. **Starting Installation**
To install the Cardsetup software insert the CD-ROM into a CD-ROM drive, open your explorer.exe and view the CD's content. Double clicking setup.exe will start the Setup Wizard, guiding you through the installation. The setup can be cut short anytime by clicking the "Cancel" button.

5.2. **Destination Folder**
First you will be asked for the software's destination folder. A default install folder is offered and can be changed by pressing the Browse button.

![Choose Destination Location](image)

*Press "Next" to continue installation.*
5.3. **Program Folder**

The next step requests to select a Program Folder, which is accessible via the "START" menu. The predefined folder can be used or changed to the individual needs.

- Press "Next" to continue installation.
5.4. **Copying Files**

All the information from the previous pages are displayed, check the settings and press "Next" to start copying the files or "Back" to edit the settings again.

![Figure 3  Start Copying Files](image)

5.5. **Setup Complete**

After setup has installed all files the Setup Complete window will appear. Press cursor on "Finish" to complete the installation.

![Figure 4  Setup Complete](image)
6. **Starting Software**

6.1. **Main Screen**

Start the Cardsetup Software via your "START" button on the task bar and select "Programs" and the previous defined destination folder. The following main screen will appear:

![Figure 5 Main Window](image)

The main window is divided in:

6.2. **MENU Bar**

This is the standard WINDOWS menu bar and is the upper bar in the main window.

6.3. **TOOLBOX Bar**

Is located under the menu bar and has icons with shortcuts.

6.4. **CARD TREE Window**

Is the white window on the left in the main window. The window shows the Flash Card tree for the current used project. Content depends on allocated card type.

6.5. **BROWSER Window**

Is the white window on the right side of the main window. The window operates like a normal browser.

6.6. **MESSAGE Window**

The message window is the gray part at the bottom of the main window. This window shows messages from the program. Status information and missing links will be displayed here, also.
7. **Menus & Submenus**

7.1. **File Menu**

In this menu there are 4 choices and "Exit" for finishing the Cardsetup application.

7.1.1. **Start a new Project**

Every time you create a new data set for a card, you start with "New". See also "Creating a Music Card", page 26 and "Creating an Announcement Card", page 16.

7.1.2. **Open an existing Project**

If you have a previously defined data set and want to open it you will start with "Open". This has the same effect as opening the project in the navigator toolbox. See figure 9.

7.1.3. **Save the current Project**

If data compilation is finished, the current project for later review or additions can be saved. The file ending is .dp. This has the same effect than as savening (figure 6) in the navigator toolbox.

7.1.4. **Save the current Project as new Project**

In order want to save the current project under a new name select "Save As".

![Figure 6 File Menu](image)

**Option Menu**

In this menu there are two choices :

7.2.1. **Change the settings for the current Project**

For each project can be change the settings individually. Submenu "Application" allows to select and define languages. Submenu "Card" allows to change the configuration parameters of the card.

![Figure 7 Options Settings](image)

7.2.2. **Create the final player card**

If the project is finished, create the final player card with this submenu entry. The creation of the card includes the checking of the links to ensure that nothing was forgotten to include. If there is
an error during this check the card will not be created. In this case the lower grey window will
give the error information. Double clicking on the errors will show directly the problem.

Figure 8  Option Create Card

7.3. **Navigator Toolbox**

The navigator toolbox (Fig. 9) in the upper window offers the following features from left to
right. The first 3-button block offers:

7.3.1. **Project Management**

with shortcuts to

- open an existing project
- save the current project
- select parent directory

The second 3-button block offers:

7.3.2. **Integrated MP3 Player**

The Cardsetup software comes with an integrated MP3 player supporting this basic functions:

- play selected file
- pause playing
- stop playing

For playing a file, the file must be selected in the right window or the according link in the left
window.

From the file type selector only MP3 files are accessible.

Figure 9  Navigator Toolbox
8. **Creating an Announcement Card**

Follow the paragraphs to create an Announcement Card.

8.1. **Introduction**

The program was designed to allow context sensitive operation. The Context Menu is invoked by pointing to the according mission or announcement and pressing the right mouse button. The following figure shows the Context Menu:

![Context Menu for Announcement Cards](image)

Figure 10  Context Menu for Announcement Cards
8.2. **Setting up the Project**

Select **File -> New -> Announcement**. The left window will show the structure of the announcement card and a window will open, asking for a mission name.

This can be a flight with flight number. Enter a mission name and press "OK". The mission name will appear in the left window. By pointing to the mission name and pressing the right mouse button you can select from a context sensitive menu via also.

There is always a mission called **MUSIC**. You can't delete this mission, if you don't use it, it will not be generated at the card. Use this mission to copy pure music files to the card. You can select them later on the DP4100 digital player under the mission **MUSIC**.
8.3. **Definition of Mission Languages**

The next step is to select the languages for that mission. Keep in mind that every mission can have a different set of languages.

Point to the mission in the left window, press the right mouse button and select mission options. The following window will appear:

![Mission Options Window]

Select from the available languages at the left side the languages for the current mission and transfer them to the right side. If a language is needed which is not listed at the left side, define a new language with "Options" -> "Settings" -> "Application". see also "Language Management", page 21.
8.4. **Defining an Announcement within a Mission**

To define an announcement within a mission point to the mission with the mouse, right click and select "Add Announcement". Announcement name has to be defined. Enter a name like BOARDING or whatever announcement might fit. After pressing "OK" the announcement will appear in the left window, showing the selected languages with the banners (if defined, otherwise empty). The left window should show something like:

![Figure 13 Announcement Languages](image-url)
8.5. Assigning an Announcement

To assign an announcement select a MP3 file from the right side. Move the MP3 file with the left mouse button pressed directly to the language (drag & drop). An informational window will appear giving information about the size and location of the MP3 file. Click "OK" and the link is established.

Assign a MP3 file to every language of your announcement.

![Figure 14 Announcement File](image)

**Important:**
The DP4100 is only supporting the 8.3 file format. That means that the file does not have longer file names than 8 characters and 3 characters for the extension after the dot. The equipment will not recognize longer filenames even if they are reduced to 8 characters by truncation. Please rename all files accordingly before you start to drag & drop.

8.6. More Missions and Announcements

More Missions and Announcements can be inserted to the project. Repeat the previous steps to add more missions and announcements.

8.7. Removing Missions and Announcements

To remove missions and announcements by pointing to the according mission or announcement and press the right mouse button. In the Context Menu select "Delete". If you delete a mission, all announcements within this mission are also deleted.

8.8. Overwriting Links

In case a wrong MP3 file is selected take the desired one and drag and drop it again. A confirmation will be required.

![Figure 15 Existing Link Warning](image)
8.9. **Application Settings**

The application settings window allows to set the standard working directory path. Under "Startup Directory" this entry can be modified to the needs.

8.9.1. **Language Management**

There are hundreds of languages used all over the world. To allow operation all over the world the program supports language management. For the current project a set of languages can be defined with the possibility to mark them available for selection. In the following figure only 6 languages are marked for usage.

If it is wanted to delete a language, select the language, mark the language with a left-click and press the according button. If it is wanted to add a language press the "New" button. Press "Ok" to close the Application Settings window with saving the changes, press "Cancel" to close the window without saving the changes.
8.9.2. Defining a new Language

To add a language to the pool press "New" and fill in the language window. Give a name to the language. It can be any name. Assign the language an icon, if available.

Press the "Ok" button and the language appears in the pool. Mark the checkbox of the language and the new language can be selected under MISSION OPTIONS in the Context Menu.
8.10. Saving the Project

If all links are established or just in order to save the actual work, save the project by pressing the floppy button in the TOOLBOX or selecting "File" -> "Save as" in the menu bar. Anyway a WINDOWS typical "save as" window will appear. By default the working directory from the Application Settings is used. Enter a project name and save the project.

Figure 18  Saving the Project
8.11. Creating the Card

Now the creation of the Flash Card can be done. Use right mouse click to open the Context Menu and choose "Create Card". The program will now check all links in the project to ensure that all announcements have a valid link. If a link is missing the message window will produce an output like:

```
Time: 16:29:38
Checking music ...
Warning: No tracks are present! (Mission Music won't be created)

Checking announcements ...
Error: FLIGHT01/BOARDING/German ... Link missing!
Error: FLIGHT01/BOARDING/French ... Link missing!
2 Error(s)
```

**Figure 19 Link Error**

In this case 2 links are missing, that means there is no MP3 assignment for BOARDING/GERMAN and BOARDING/FRENCH. By double clicking the error the program will show the actual settings.

```
Announcement file

<table>
<thead>
<tr>
<th>File</th>
<th>None</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>0 kB</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Link missing</td>
<td></td>
</tr>
</tbody>
</table>
```

**Figure 20 Announcement File Information**

With pressing "Change" can be assign a MP3 file. After file selection press ENTER. You can also use the recommended drag & drop operation to assign a MP3 to an announcement.
8.11.1. **Select destination drive**

To check the links again open the Context Menu and select "Create card" again on. If all your links are ok, the following window will appear:

![Create card dialog box](image)

Select the drive which has the PCMCIA slot connected. In our example drive M: is used. Make sure an empty Flash Card is inserted and formatted.

Enter a name for the card and press OK. The cards directory structure will be created and all files will be copied and generated.

The Flash Card is now ready for operation in Becker Avionics DP4100 Digital Player. The card name will be displayed on the DP4100 display if is the card inserted. It's not the card label to be seen under the Flash-Card properties!
9. Creating a Music Card

Follow the paragraphs to create a Music Card.

9.1. Introduction

The program was designed to allow context sensitive operation. The Context Menu is invoked by pointing to the left window and pressing the RIGHT mouse button. The following figure shows the Context Menu:

![Figure 22 Context Menu Audio](image)

9.2. Setting up the Project

Select "File" -> "New" -> "Music". The left window will show the structure for the music card.

![Figure 23 Music Card Structure](image)
9.3. **Adding a Track**

Tracks in MP3 format can be added easily by dragging the tracks from the right explorer window and dropping them to the music symbol. You also can add tracks with the Context Menu. In both cases the following window will appear:

![Figure 24  Track File Window](image)

The entries "Title" and "Artist" should be filled in. They will appear in the DP4100 display for easy identification. Press "OK" to close the window.

To see what title and artist are behind a track, move the mouse over the track and a yellow cursor window will show artist and title.

**Important:**
The DP4100 is **only** supporting the **8.3 file format**. That means that the file does not have longer file names than 8 characters and 3 characters for the extension after the dot. The equipment will not recognize longer filenames even if they are reduced to 8 characters by truncation. Please rename all files accordingly before you start to drag & drop.

9.4. **Deleting a Track**

You can delete a track by marking the track with a left click and then open the Context Menu with a right click of the mouse. Select "Delete" to delete a track from the tree.

9.5. **Changing Track Order**

The order of tracks can be changed by selecting a track with the left mouse click and moving the track up or down in the current track list with pressed button. The naming track 01, track 02 ... is not changed but the contents are changed. Check the contents by moving the cursor over the track and review the yellow windows contents.
9.6. **Card Settings**

The “Settings” entry enables adjustment of the default behavior of the DP4100 with power on. Defined settings can be adjusted during normal operation. These adjusted settings will reset to the default values (described here) after the DP4100 is powered on again.

![Figure 25 Cardsetup](image)

By double-clicking the “Settings” entry the following window will appear:

![Figure 26 Settings](image)

9.6.1. **External Wiring**

If the installation has an external potentiometer, this can be connected to pin 17 for volume control or alternatively connected to pin 22 for Illumination control. Please check your installation and select the correct wiring entry in this field.
9.6.2. General
Selection of the “Auto Start” check box enables the DP4100 to play automatically after power is switched on. By default (if you start a new project) this function is disabled. Selection of the “Internal volume Adjustment” box enables volume control with the rotary switch located on the DP4100 panel. This function is disabled by default.

Attention: If you select “External volume Control” (External wiring) and “Internal volume Adjustment” (General) then “Internal Volume Adjustment” will supersede “External Volume Control”.

9.6.3. Brightness
Brightness for the panel and the display can be adjusted individually according to the installed position in the aircraft. These values can be adjusted during normal operation but are reset to the default values on every new application of power.

9.6.4. Volume, Treble, Bass
This values can be adjusted individually according the installed position in the aircraft. These values can be adjusted during normal operation but are reset to the default values on every new application of power.

9.6.5. Minimum Volume
This entry defines the minimum volume for the DP4100. If you use internal or external volume control, the volume will not be lower than the value defined within here.

9.6.6. Delay between Tracks
This entry allows you decide the time of silence between to consecutive tracks.

Remark:
If you do not want to have these initial values every time the player is switched on, remove the relevant entries from the .ini file manually. In this case the last chosen values are stored in the DP4100 non volatile memory and remain for each application of power. It is not recommended to modify the .ini file manually, but this may be necessary for certain applications.

We recommend that the correct DP4100 setup is incorporated on initial installation into the aircraft and stored within the project. This ensures that the optimal values are used every time the DP4100 player is switched on.
9.7. Saving the Project

If all links are established or just to save the actual work, save the project by pressing the floppy button in the TOOLBOX or selecting "File" -> "Save as" in the menu bar. Anyway, a WINDOWS typical "save as" window will appear. By default, the working directory from the Application Settings is used. Enter a project name and save the project.

![Figure 27: Save Audio Project](image-url)
9.8. Creating the Card

For creation of the Flash Card, use the right mouse click to open the Context Menu and choose "Create card". A music card has always valid links unless referenced files are (re)moved. This will be checked here.

9.8.1. Select destination drive

To check the links again open the Context Menu and select "Create card" again. If all the links are ok, the following window will appear:

Select the drive which has the PCMCIA slot connected. In this example drive N:. Make shure an empty Flash Card is inserted and formated.

Enter a name for the card and press "OK". The cards directory structure will be created and all files will be copied and generated.

The Flash Card is now ready for operation in Becker Avionics DP4100 Digital Player. The card name will be displayed on the DP4100 display when the card is inserted. It's not the card label that will be displayed under the Flash Card's properties!